Indigo Terminal Emulation Software ®

Indigo is a powerful terminal based communication software
for telnet, SSH, and serial communications. Indigo offers
many tools and functions that cannot be found in competing
terminal softwares. Indigo is a complete replacement for
TELNET ® and HYPERTERM®. Indigo supports serial
based connections using the comuters hardware serial
communications ports and network based connections
termianl connections. Indigo supports the following network
protocols: TELNET, SH1, SSH2, REXEC, RSH, RLOGIN,
ECHO, DAYTIME CHARGEN, and raw IP socket
communications. Indigo also allows you to view the
incoming data in multiple byte representation formats such as
ASCII, DECIMAL, HEXADECIMAL, OCTAL, BINARY,
or user defined custom formats.
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General Overview
Sessions / Connection Types:
Terminal Sessions
Indigo's primary function is for remotely
communicating and monitoring terminal devices and
servers.
Indigo supports the folling connection methods and
communications protocols:
TELNET
SERIAL (RS232)
REXEC
RSH
RLOGIN
ECHO
DAYTIME
CHARGEN
RAW
SSH1
SSH2
SSH AUTO (auto negotiate between SSH1 &
SSH2)
Web Sessions
Indigo also has an integrated web browser for
previewing/surfing web pages. This web browser is

build in for convenience and is treated like other session
windows. This integrated browser is build on Microsoft
Internet Explorer technology.
Features:
Session Manager
Indigo contains an easy to navigate session manager
dockable tool window. This session manager organizes
and provides quick access to any supported Indigo
session. All of a sessions settings are stored in session
files, these files are grouped and displayed here in the
session manger tool window.
Data Converter
Indigo provides two data converting utilities. First, in a
terminal session, the user can select what data byte
format they would like to view the incoming data in.
The options are ASCII, ASCII w/ Control Codes,
HEXADECIMAL, HEX w/ control codes, OCTAL,
BINARY, Byte Analysis, or user customized format.
Second, a data converter tool window will allow you to
highlight data in a terminal session window or drag and
drop ASCII data into the tool window to convert the
data to a user selected data format.
Command Library
The command library is a tool window that allows
terminal command to be saved and recalled to files. To
send to commands from the command library you can
drag and drop to the terminal command window or
double click the command entry.
Variable Manager
The variable manager allows you to set and recall

variables fur use with terminal send commands. When a
command is sent to the terminal session, any detected
variable is replaced with the variable value.
Command Repeater
The command repeater allow you to populate a list of
commands and variables that can be set to repeat at
defined intervals. The variables can also be manipulated
mathematically on each cycle. This tool is particularly
useful for testing equipment.
Custom Data Format Editor
Custom data format editor allow you to customize how
incoming data bytes are displayed in the terminal
session window.
Command Macros
Command macros allow frequently used terminal
session commands to be stored as menu items and
hotkeys.
Syntax Colorization
Syntax colorization will colorize user defined data
strings in the terminal session window.
Serial Pass Mode
Serial pass mode allows you to create a serial session
that uses two com ports to listen to the data transfer
from two connections or devices.
Data Logging
Terminal session data can be logged to a local file. Each
session maintains it's own log files.

Many more features.....
Line numbering, printing, pause incoming data, quick
connect, reconnect, recent connection list, window state
(location) save and recall, extreme configuration
portability, and more.
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Installation
Indigo is distributed in an easy to use single file installation
utility. Simply follow the installation prompt instructions and
you will have the software installed in a matter of seconds.
The installation utility will only prompt to reboot you
computer if certain system files were in use or missing from
you computer. You can optionally install Indigo in a
directory path of your choosing.
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Licensing
Registration:
Indigo must be licensed to the computer it is installed on. A
single license may only be installed on a single computer.
License transfer is available.
A quick and easy online registration method is provided for
Indigo. When you install Indigo, upon starting the program,
the splash screen will provide an option to register the
software. The registration dialog will then display a software
serial number. When purchasing indigo online, you will
simply enter this software serial number in the online
purchase form and an authentication key will be emailed to
you.

Upon recieving the authentication key, enter it into the
registration dialog. Also, enter the user name you would like
the software registered to. Select the 'Register' button and a
success message will be displayed indicating that Indigo is
fully licensed.
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Layout
Indigo provides an extremely flexible user interface layout
With the many features Indigo supports, maintaining a
usable user interface is a key focus. Indigo puts you in
complete control of how the user interface is laid out.
The session window is always in the center of the screen.
Indigo supports multiple document interface (MDI) which
allows several session to be open at any time. These session
windows can be tiled horizontally, tiled vertically, or
cascaded. You can easily navigate to any of the session
windows by using the "Window" option located in the main
menu.
Indigo also provides convenient toolbars for quick access to
highly used features. You will find Indigo's Quick Connect
toolbar to be very useful in situation where you need to
connect to a telnet or terminal session and do not want or do
not need to setup a session. Each of the toolbars can be
turned on or off directly from the "View" menu.
Indigo powerful tools are provided though tool windows.
Each of the tool windows can be docked to any side of the
main form. In addition to being docked to any edge, the tool
windows can be stacked on top of each other or tabbed inside
each other. The tool windows can also be pinned down to
maximize the user screen real estate. When a tool window is
pinned down, it will only display a small title bar on the edge
it is docked to. As you move the mouse over the title bar, the

tool window reveals itself for use. When the mouse is moved
out of the tool window, it again hides itself. Each of the tool
windows can be turned on or off directly from the "View"
menu.
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Program Menus
Indigo hosts several multi-layer menus. You can access all
tools and features of Indigo through its menus.

File Menu

New Terminal Session - used to create new telnet or
serial terminal sessions.
New Web Browser - used to create a new web url
session.
Open - opens a terminal session from a file browser.
Close - closes the current session window in focus.
Close All - closes all open session windows.
Save Data - saves the terminal session data to a text
file. If the session already has been saved as a text file,
this option will not prompt for a new text file name and
location.

Save Data As - saves the temrinal session data to a text
file, allowing you to specifiy the text file name.
Save Session As - save the current session window in
focus to another file.
Export Data as File - export session data of current
session window to a text file. If text is highlighted in the
session window, only the highlighted text will be
exported to the text file.
Export Data as Email - export session data of current
session window to an email. If text is highlighted in the
session window, only the highlighted text will be
exported to the email body.
Print - print the session data of current session
windows. If text is highlighted in the session window,
only the highlighted text will be printed.
Recent Sessions - this menu displays a list of the
recently opened session files.
Exit - exits the program.

Edit Menu

Cut - cut selected text.
Copy - copy selected text.
Paste - pastes text from clipboard.
Find - used to find text in a sessions data window.
Find Next - finds next occurrence of text.
Select All - selects all text in the current session
window.

Goto Line - navigates cursor to specific line number.
Program Preferences - opens the program preferences
dialog for user configuration.

View Menu

Session List Bar - toggles the display of the session list
bar. The session list bar is shown at the bottom of the
screen and lists all open sessions. You can access any of
the open sessions directly by clicking on the session title
in the session list bar.
Status Bar - toggles the display of the status bar. The
program status bar is shown at the bottom of the screen
below the session list bar. The status bar indicates the
current session in focus and provides additional session
properties.
Session Manager - toggles the display of the session
manager. This is a tool window that organizes the
session files in a tree structure.
Command Library - toggles the display of the
command library. This is a tool window that allows a
user to enter or send terminal commands from a list.
These lists of commands can be stored or loaded as
individual libraries of commands.

Data Converter - toggles the display of the data
converter. This is a tool window that can dynamically
convert selected bytes from the session window into
alternate formats, i.e. hexadecimal, decimal, octal,
binary, and event user defined representations.
Repeater - toggles the display of the command repeater.
This is a tool window that can be used to automate the
sending of lists of commands to a terminal session.
Variable Manager - toggles the display of the variable
manager. This is a tool window that allow the user to
enter variables name and values. These variables can be
embedded in command libraries, command repeater
lists, and command macros. Before Indigo sends a
command string, it will replace any variables with the
values found in the variable manager.
Quick Connect Toolbar - toggles the display of the
quick connect toolbar. The quick connect toolbar allows
users to enter a telnet server address or serial terminal
setting for a connection without having to create a
session file.
Recent Session Toolbar - toggles the display of the
recent session toolbar. The recent sessions toolbar is a
quick and convenient location to access and load
recently opened terminal sessions.
Window States Toolbar - toggles the display of the
window states toolbar. The window states toolbar allows
the user to store the layout of the program's windows.
This includes the size of the window and the position on
screen. Selecting a window state will return the program
to the saved position and size.
Macro Toolbar - toggles the display of the macro
toolbar. The macro toolbar allows the user to execute
the first five defined macros from a convienantly
accessible toolbar.
Line Numbers - toggles the display of line numbers on
the current open session window.
Line Highlight - toggles the display of a line
highlighter on the current open session window.

Tools Menu

Edit Custom Data Conversion Format - opens the
customer data format editor. With the custom data
format editor you can create very specific character
representations for byte conversion. The custom data
formats can be used directly in a session window or in
the customer data converter tool window.
ASCII Chart - toggles the display of a built in ASCII
conversion chart.
Syntax Color Editor - opens the syntax color editor.
Indigo can display incoming session data in specialized
user configurable colors for keywords. This feature is
especially helpful if you are looking for specific strings
or words.
Window States - The window states feature allows the
user to store the layout of the program's windows. This
includes the size of the window and the position on
screen. Selecting a window state will return the program
to the saved position and size.
Dump Raw File - This tool will allow you to open a
raw text file and send the data in the file directly to the
current terminal session. This feature also includes the
ability for you to set the transmission byte rate. (bytes /
milisecond)

Session Menu

Connection - allows you to connect, disconnect, or
reconnect a terminal session.
Standard Terminal Mode - sets the terminal session
data window to standard mode. Standard mode is a raw
text based view and does not include VT emulation or
direct terminal keyboard input support.
Direct Terminal Mode - sets the terminal session data
window to direct mode. Direct mode is a convential
terminal emulation view which does support VT
emulation and direct terminal keyboard input support.
Clear Session Data - clears the session data text in the
current session data window.
Clear Command Buffer - clears the command buffer
of commands sent in the current session window.
Data Format - allow you to select how you want the
incoming data to be represented on screen of the current
session window. You can also configure the the data
byte format and the data byte grouping to be displayed.

Reboot - sends the session configured reboot command
to the current session window, then disconnected and
attempts to re-connect after a specified elapsed time.
Pass Mode - this feature if a serial RS232 tool only.
Using two com ports on the computer, pass mode allows
the computer to see data transfer from one device to
another. Essentially it allows the computer to sniff the
data off the line between two devices.
Log Data To File - this feature will set up a logging file
in which to log all incoming data for the current selected
session window.
Local Echo - toggles the current session windows local
echo feedback.
Pause Incoming Data - this feature allow you to stop
receiving incoming data to the screen while maintaining
the connection.
Syntax Color Filter - this option configures the current
session data window to use a user defined colorization
filter for all incoming text data.
Session Properties - displays the sessions properties
dialog.

Macros Menu

Macros - User configured macros are simply commands
that are sent directly to the current session window upon
the menu selection or hotkey key press.
Edit Macros - allow the user to configure system wide
command hotkey macros. (Note: multiple command can
be entered into a single line by placing the pipe symbol

'|' between each command)

Window Menu

Tile Vertically - arrange all open session windows tiled
vertically on the screen.
Tile Horizontally - arrange all open session windows
tiled horizontally on the screen.
Cascade - arrange all open session windows cascaded on the screen.
Maximize - maximize the current session window.
Normalize - restore the current session window to a
normalized state.
Minimize - minimize the current session window.
Split Horizontal - this will split the session data
window horizontally. Splits provide a multi dimensional
view on the data allowing you to view different parts on
the data session in a single view.
Split Vertical - this will split the session data window
vertically. Splits provide a multi dimensional view on
the data allowing you to view different parts on the data
session in a single view.
Next - this changes focus to the next open session
window.
Previous - this changes focus to the previous open
session window.

Help Menu

About - displays the program's about dialog. You can
view the program version information here.
Indigo Help - displays the program's help file.
Visit shadeBlue Online - opens an internet browser to
www.shadeblue.com
Web Update - this feature will connect online,
determine if any updates are available and allow you to
automatically download and install program updates.
Registration - this will open the registration dialog. You
can view the existing registration information or
deregister the license from this dialog.
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Components & Tools
Indigo provides many component and tools that give Indigo
its power and versatility.
Components & Tools Program Preferences
Session Manager
Terminal Sessions
Web Sessions
Quick Connect
Data Converter
Macros / Macro Editor
Command Library
Variable Manager
Command Repeater
ASCII Chart
Window States
Dump Raw File
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Program Preferences
Indigo's can be configured through its program preferences
dialogs. To access program preferences, click on the
"Program Preferences" option in the "Edit" menu.

General
Display Splash Screen - this option will display or hide the
splash screen as program startup.
Default Windows Telnet Client - if this option is enabled,
Indigo will configure the Windows operating system to use
Indigo as the default telnet program when a telnet protocol
handler is clicked. The telnet protocol handler looks much
like a URL, except the protocol specifier is labeled "telnet".

Here is an example of the format: telnet://localhost:23
Form Memory - if this option is enabled, Indigo will store
size and position information about each dialog, including
the main form. When to program is restarted, all of this form
data will be loaded and applied to Indigo's dialogs.
Auto Resize - this option will allow you to specify how you
want new session windows to appear on screen.

Last Session - if this option is enabled, the Indigo will
automatically open the last session file at program startup.
Session Directory - this option will allow you to change the
default session file path for Indigo.
Misc - The default session properties are discussed under the
advanced tools topic heading.

The final tab in the program preferences dialog is the "Global
Commands" tab. You can enter commands into the global
command list. When a session file is loaded if it is subscribed
to the global command list, it will automatically send these
commands upon a successful connection. To subscribe a
session to the global command list, see the "Session
Properties" help topic.
(Note, the session window will send these global commands
in the order they are displayed here. You can select an entry
and used the arrow up/down buttons at the lower right to
modify the order of command entries.)
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Session Manager
Indigo's terminal session are displayed in the Session
Manager tool window.

The session manager is displayed in a tree view to help
organize session files. double clicking a session file will
immediately open the session. Right-clicking on a folder will
display the popup menu shown below. This menu will allow
you to create new folder groups, remove the selected group
folder, add a session file to the group folder, or rename the
group folder.

Right-clicking on a session file will display the popup menu
shown below. This menu will allow you to open the session
file, add a new session file, remove the session file, rename
the session file, or edit the session's properties.

The Session Manager also provides an alternate view of the
session tree. The first button in the toolbar at the top of the
Session Manager will toggle the view between tree view and
list view.

The second button in the toolbar at the top of the Session
Manager is a filter. You can filter session types you do not
want to display in the Session Manager. The combo drop
down box in the toolbar at the top of the Session Manager
sets the root of the session file tree. Changing this will limit
the visible session and group folders to the path specified in
the combo box.
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Terminal Sessions
Indigo's terminal session open into a session window. The
session window is always in the center of the screen. Indigo
supports multiple document interface (MDI) which allows
several session to be open at any time. These session
windows can be tiled horizontally, tiled vertically, or
cascaded. You can easily navigate to any of the session
windows by using the "Window" option located in the main
menu.

The session window provides a session toolbar at the bottom
of the session window. The first button which is on the left
side of the toolbar allows you to toggle the session window

view between Standard Terminal Mode and Direct Terminal
Mode.
Go To Direct Terminal Mode
If this button icon is displayed, the session view mode is
currently in Standard Terminal Mode. Pressing this
button will take you to Direct Terminal Mode.

Go To Standard Terminal Mode
If this button icon is displayed, the session view mode is
currently in Direct Terminal Mode. Pressing this button
will take you to Standard Terminal Mode.

(Click here for more information on Standard & Direct Terminal Modes)

The next item on the session toolbar is the command combo
box. All data commands are send to the terminal session
through the command combo box. You can type data
commands into this box and press the "Enter" key when
ready to transmit the data to the terminal session. This
command combo box will also buffer the last commands sent
and make them accessible via the drop down. This makes it
very easy to resend previous commands. You can set the
number of commands to buffer in the session properties.
(Note: you can send data command in other byte formats.
Please see the "Advanced Send Commands" help topic under
the "Advanced Tools" topic heading.)

The next button in this toolbar will access the controls to

connect, disconnect, or re-connect to the terminal session.

The next button in the session toolbar changes the display
format of the incoming data bytes. This feature is extremely
useful when you need to analyze specific byte values.
Additionally, for base formats such as DEC, HEX, OCTAL,
and BINARY, you can change the byte grouping option to
display bytes as single bytes, words (2 bytes), or dwords (4
bytes).

The next button in the session toolbar is to pause incoming
data. this feature allows you to stop receiving incoming data
to the screen while maintaining the connection..

The last button on the session toolbar provides access to the
remaining session tools.

Reboot - sends the session configured reboot command
to the session window, then disconnected and attempts
to re-connect after a specified elapsed time.
Log Data To File - this feature will set up a logging file
in which to log all incoming data for the session
window.
Local Echo - toggles the session windows local echo
feedback.
Pause Incoming Data - this feature allow you to stop
receiving incoming data to the screen while maintaining
the connection.
Syntax Color Filter - this option configures the session
data window to use a user defined colorization filter for
all incoming text data.
Edit Session Properties - displays the sessions
properties dialog.

Additionally, many tools and features can be accessed
directly using the session windows right-click menu. With
the mouse place the pointer in the session data window and
press the right mouse button.

Connect/Disconnect - allows you to connect or
disconnect a terminal session.
Reboot - sends the session configured reboot command
to the session window, then disconnected and attempts
to re-connect after a specified elapsed time.
Clear Session Data - clears the session data text in the
session data window.
Clear Command Buffer - clears the command buffer
of commands sent in the session window.
Copy - copies the selected text to the clipboard.
Find - used to find text in a sessions data window.
Find Next - finds next occurrence of text.
Goto Line - navigates cursor to specific line number.
Data Format - allow you to select how you want the
incoming data to be represented on screen of the session
data window. You can also configure the the data byte
format and the data byte grouping to be displayed.
Advanced
Reboot - sends the session configured reboot
command to the session window, then disconnected
and attempts to re-connect after a specified elapsed
time.
Log Data To File - this feature will set up a

logging file in which to log all incoming data for
the session window.
Local Echo - toggles the session window's local
echo feedback.
Pause Incoming Data - this feature allows you to
stop receiving incoming data to the screen while
maintaining the connection.
Syntax Color Filter - this option configures the
session data window to use a user defined
colorization filter for all incoming text data.
Edit Session Properties - displays the sessions
properties dialog.
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Web Sessions
Indigo also supports an internal web browser. Web site links
can be stored as web sessions. Opening a web session
displays the web page inside Indigo's main window. The
standard web navigation buttons are accessible via the web
session toolbar located at the top of the web session window.
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Quick Connect
Indigo provides a way to establish a terminal session without
having to create a session file. This is called Quick Connect
and it is accessible via the Quick Connect Toolbar. If the
Quick Connect Toolbar is not visible you can enabled it by
selected the "Quick Connect Toolbar" option form the
"View" menu.
The first button in the Quick Connect Toolbar is the session
connection type. You can choose from telnet session, serial
session, or web session.

In the telnet quick connect dialog, simply enter the IP address
or hostname of the server you which to connect to. Press
"Enter" or the arrow button to open the session.

In the serial quick connect dialog, enter the com port, baud

rate, parity, stop bits and data bits settings of the serial device
you which to connect to. Press "Enter" or the arrow button to
open the session.

In the web quick connect dialog, enter the IP address or
hostname of the web site you which to connect to. Press
"Enter" or the arrow button to open the session.
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Data Converter
Indigo provides a data conversion utility to examine data
bytes from the terminal session in other byte formats than
ASCII. These alternative byte formats include hexadecimal,
decimal, binary, octal, and other variations included a user
defined custom format.
The Data Converter is a tool windows that be be docked,
pinned, or positioned anywhere on the screen. The first
button in the Data Converter Tool Window in used to enable
or disabled automatic data conversion. If this option is
enabled, then any text that is selected in the current session
window will be automatically converted on the fly in this
tool window.

If this option is not enabled, the Data Converter will only
work in manual mode. In manual mode, you can simply
select some ASCII text and drag it into the Data Converter
Tool Window. The Data Converter will convert and ASCII
data dropped into it in to the specified format.

To choose a different data representation, simply click on the
second button in the Data Converter Tool Window. This will
provide a drop down list of conversion options.

The Grouping option in the data format menu allows the
representation of multiple bytes grouped into Words (2 bytes)
or DWords (4 bytes). This grouping option is available to the
base formats such as HEX, DEC, OCTAL, and BINARY.
(Note: to learn more about custom data formatting, please see
the "Custom Data Format / Editor" help topic under the topic
heading "Advanced Tools")
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Macros / Macro Editor
Indigo provides user configurable macro commands. Macros
are available via the "Macro" menu and via program hot
keys.

Macros - User configured macros are simply commands
that are sent directly to the current session window upon
the menu selection or hotkey key press.
Edit Macros - allow the user to configure system wide
command hotkey macros.

In the Macro Editor, you can enter macro commands,

enabled/disable macros, and give them friendly names. The
friendly names are what will be displayed in the "Macro"
menu. Additionally you can save and recall separate macro
libraries. This make sharing your macros to another user or
another computer a very simply task.
(Note: multiple command can be entered into a single line by
placing the pipe symbol '|' between each command)
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Command Library
The Command Library Tool Window allow a user to create,
manage, and share libraries of commands. Each list of
commands is stored as a library file. Library files can be
loaded at any time. If the Command Library Tool Windows is
not visible, you can enable it by selecting the "Command
Library" option in the "View" menu.
Double clicking a command entry in the command library
will automatically send the command to the current session.
Optionally you can drag a command entry to the command
combo box in a session window to make modification
beforesending it to the connected terminal session.
Right clikcing the command libray provides the same options
as the Command Library toolbar.

To edit the Command Library, you must enter edit mode. Do
this by clicking on the "E" button on the toolbar or popup
menu. Once in edit mode, clicking a command entry will
allow you to edit the item rather than sending it to the
session.
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Variable Manager
Indigo provides a very sophisticated variable replacement
feature. This feature is offered in the Variable Manager Tool
Window. If the Variable Manager Tool Windows is not
visible, you can enable it by selecting the "Variable
Manager" option in the "View" menu.

The fist button in the Variable Manager Tool Window
enabled and disabled the Variable Manager replacement
system. The next three buttons create new Variable Manager
libraries, open existing Variable Manager libraries, and save
the current Variable Manger Library respectively. The last
button with the "E" symbol is the edit button. Use the edit
button to enter or edit variable names and values. When
completed, click the "E" button again to return to normal use
mode.

You can use these variables in a command line throughout
the program by encapsulating the variable name in square
brackets. For example to send a command "PING 127.0.0.1"
we could enter this command instead "PING [SRV]". Indigo
will detect the square brackets and attempt a variable lookup.
For the variable named "SRV", it finds the value "127.0.0.1"
so it replaces the variable with the appropriate value. The
dynamic variable replacement will allow you to create
commands without hard coding particular text that can
change frequently.

Variables can be embedded in the command entry combo box
of the session window, Command Macros, Command Library
entries, and Command Repeater entries. Variable can also be
embedded in other variables. For example, see the variable
table below:

FullName
FirstName
LastName

[FirstName]
[LastName]
Jane
Doe

If we send the command "Hello [FullName]" the Variable
interpreter would return "Hello Jane Doe", deriving each
variable separately.
(Note, beware of defining variables within variables where a
potential infinite replacement loop could occur. In this event
Indigo will protect itself by only allowing up to five
recursion replacements before quitting the replacement
algorithm.)
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Command Repeater
Indigo provides an automated command repeating tool. The
Command Repeater Tool Windows takes concepts from both
the Command Library and the Variable Manager and
combined them into a specialized tool for creating looping,
repeating commands with the ability to mathematically
operate on variables during the loop process.
The Command Repeater maintains it's own list of commands.
Command Library files can be imported into the Command
Repeater.

To enter into edit mode, click the "E" button in the Command
Repeater toolbar. This will allow you to enter new or modify
existing command entries. In addition to the command text
and description, there is also an enabled/disable checkbox.
This allows you to select with commands will participate in
the repeating loop process.

On the "Variables" tab you can enter multiple variables in the
list.

To enter into edit mode, click the "E" button in the Command
Repeater toolbar. This will allow you to enter new or modify
existing variable entries.

Enabled - This option will enable or disable this

variable in the repeating process.
Variable - the variable name.
Start - sets the variable to this starting value on the
initial start of the repeating process.
Operator - mathematical operator to perform on
variable on each cycle.
Cyclic - this is the operand to be used in the
mathematical equation during each cycle of the
repeating process.
Current - denotes the current value of the variable. This
field will change as the repeating process cycles and
performs each mathematical equation.

The Variable Manager Tool Window also supports a right
click menu for quick access to the same features offered on
the toolbar.

Once all of you command entries and variable entries are
complete you will need to configure the Command Repeater
settings. Click the circular arrows button in the toolbar or
popup menu to display the Command Repeater Settings
dialog.
You can configure the Command Repeater for continuous
playback or fixed number playback. You can set the delay in

milliseconds between each command to be sent. You can also
determine if the Command Repeater is to send the entire list
of commands on a timing cycle, or to only send a single
command and progress through the list on each timing cycle
in the repeating process.

If fixed playback is selected, an additional entry box will
appear to configure the number of cycles you want the
Command Repeater to process.

As a final option, you can elect to have the command list
cycle pointer to be reset after a specified number of cycles.
This is not the easiest tool to grasp right away, it will take
some experimenting to fully understand the capabilities of
this feature.
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ASCII Chart
Indigo's provides a quick access ASCII chart for user
reference. You can access this from the "Tool" menu or by
pressing the hotkey "F12".
The ASCII chart tool allows four seperate visual ASCII chart
representations: an ASCII table view, a simple ASCII chart,
an extended ASCII chart, and a text-based ASCII chart.

(ASCII table)

(Simple ASCII chart)

(Extended ASCII chart)

(Text-based ASCII chart)

These ASCII chart views are simply a set of HTML
based files located in the program directory. You can
change or modify these files if you would prefer a
customized ASCII chart view.
C:\Program Files\shadeBlue\Indigo\ascii.htm
C:\Program
Files\shadeBlue\Indigo\ascii_simple.htm
C:\Program
Files\shadeBlue\Indigo\ascii_extended.htm
C:\Program Files\shadeBlue\Indigo\ascii_text.htm
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Window States
Indigo's provides a unique size and positioning feature
called Window States. There are five window state slot
locations that you can store to. Simply set the program
window to the location on the screen and to the size that you
like, then click the "Save Window State" option in the "Tools"
/ "Windows States" menu.

A windows state save dialog will appear where you may
select the window slot. You can choose if you want to record
both the window size and position, or just one. You also can
give the window slot a friendly name which will appear in
the menu. Complete by pressing the "Save" button.

Now you can move the program window to another
location or resize the program window. At any time you
can now select the window slot from the "Tools" /
"Windows States" menu and Indigo will immediately
move and resize back to the recorded size/position.
Indigo also provides quick access to the window states
via the Window States toolbar. The green buttons
numbered one through five are pressed to recall a
window slot. The last button with the arrows is the save
window states button. If this toolbar is not visible, you
can click the "Windows States Toolbar" option in the
"Edit" menu.
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Dump Raw File
This tool will allow you to send all data withing a text based
file to the current connected terminal session. You can access
this tool form the Tools menu as show below.

Afer selecting the Dump Raw File option, you will be
prompted to select the desired text file. Upon selecting the
text file you will be promted with the dialog below:

Some terminal based devices may not be able to process the

data as fast a the computer and Indigo can transmit the data.
This tool provides to opiton to throttle the number of bytes
transmitted in a specified amount of time. You have have to
alter these settings using a trial and error method to find a
suitable rate that is compatible with you terminal device.
Simple press the Start button to begin transmitting the data
in the file to the current connected terminal session. At any
time during the data transmission, you can select the Stop
button to halt further data transmission and the Reset button
to reset the dum file tool to start at the beginning of the data
file.

Indigo Terminal Emulation Software ®

Terminal Session Tools
This section is provided to discuss and demonstrate Indigo's
session tools and features.
Terminal Session Tools Session Properties
Session Modes
Session Data Logging
Serial Pass Mode
Syntax Coloring /
Editor
Export Session Data
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Session Properties
There are many settings and parameters that can be
configured for each session. This page will walk you through
the Session Properties dialog and explain how each of the
settings affect a terminal session.
The session properties dialog consists of the following tabs:
Connection
Proxy
Terminal
Formatting
Settings
Send Commands

Connection

The connection tab provides options to configure the
terminal connection settings.
Connection Protocol
The supported connection methods and protocols are listed
below with their respective connection settings.
Telnet

Serial (RS-232)

REXEC

REXEC

RLOGIN

ECHO

DAYTIME

CHARGEN

RAW

SSH1

SSH2

SSH AUTO

Auto Connect
If the auto-connect option is enabled, the terminal session
will attempt to automatically connect each time the session is
opened.

Authentication Settings
Depending on the connection method/protocol seletect,
authentication method properties may be available for the
terminal session.

Indigo supports the following authentication modes:
Disabled - no authentication method will be used
Password (manual) - this is used when the terminal
server/device supports on on screen login prompt. If this
option is selected, Indigo will simply pass the username
and password upon connection as if you typed it in upon
connection. This option can be used in conjunction with
the Wait for Prompt option. If Wait for Prompt is
enabled, Indigo will wait until the user specific text is
received before sending the login credentials. An
example of Wait for Prompt would be somehting like
"Please Enter Username".
Password (connection) - the terminal server/device
supports a connection based login. This is common
authentication option for REXEC, RSH, RLOGIN,
SSH1, SSH2, SSH AUTO.
<return to top>

Proxy

Indigo support proxy router based connections. Simply enter
your proxy type and proxer server settings on the proxy tab
in the session properties dialog.
<return to top>

Terminal

When a terminal session window is configured to use the
Direct Terminal Mode view mode, VT emulation and direct
terminal input is supported. On the Terminal tab in the
session properties dialog, you can configure the emulation
type and the terminal screen size. Indigo also supports a
dynamic screen resizing feature. To enable dynamic resizing
set the Terminal Windows Rows to Auto Set Number of Rows
and the Terminal Windows Columns options to Auto Set
Number of Columns.
<return to top>

Formatting

The session formatting options allow you to customize the
look of a session window. You may optionally enable line
numbering, alter fonts, change colors, and choose a number
of other configurable display options.
<return to top>

Settings
The settings tab hosts a number of other session runtime
options.
Multi-Command - this option allow multiple data send
commands to be stacked in a single command line, separated
by a delimiter character. This option is enabled by default
and the pipe '|' character is the delimiter character.

Internal Commands - this option enables/disables the
internal command interpreter. See the "Internal Commands"
help topic for more information about this feature. This
option is enabled by default.
Variable Replacement - this option enables/disables
variable replacement in data send commands. See the
"Variable Manager" help topic for more information about
this feature. This option is enabled by default.
Advanced Send Commands - this option enables/disables
advanced multi-byte send commands from being interpreted
by the command interpreter. See the "Advanced Send
Commands" help topic for more information about this
feature. This option is enabled by default.
Force Window Maximized - if this option is enabled, the
session window will be forced to a maximized state each
time the session file is opened.

Command Buffer - this option allow the session window
command drop down box to store recently sent data
commands. You can specify the number of commands you
would like the session window to store. Additionally, you can
enable the Auto-Complete feature for the command drop
down box to auto suggest and auto complete the command
you are typing.

Reboot Sequence - this option configures the session reboot
options for the reboot menu item on the "Session" menu and
the session window right-click popup menu. The reboot
command is the data command sent to the device to initiate a
reboot. The auto reconnect timer is used to disconnect the
terminal session and re-establish a connection after the
specified time has elapsed.

Terminating Character - this option configures the byte
sequence that is automatically appended to each command
that is sent from the session window. This field supports the
advanced send command format such as the default of
"13,10" which represents Carriage Return & Line Feed.
You can disable this feature if you do not wish for Indigo to
automatically append bytes to each command sent.

Auto Line Wrap - this option will force data in the terminal
session data window to automatically wrap each line after the
specified number of bytes have been reached. This option is
useful for terminal sessions or devices that do not support a
formatted data output. For example, if you are
communicating via a serial connection with a raw device
protcol, the device may only return a seqience of protocol
bytes, no really intended for viewing on screen. This option
will allow you to maintain the output data on screen rather
than on long continious line of streaming data.

Post Processing Script - this option will enable received
session data to be routed through a custom script file for
processing before it is printed to Indigo's terminal data
window. An example script: PostProcessingSample.vbs has
been included serve as an example to create your own
custom scripts. Use this option with care as external scripts
can decrease the performance of Indigo.
<Click here for more information on the Post Processing Script feature>

Keep Alive - this option will enable keep alive data packets
to be sent to the connected terminal session after the
specified number of seconds of inactivity. Your terminal
server/device must support keep alive functionality..

<return to top>

Send Commands
The send commands tab lists the auto send commands and
which auto send command lists this session is subscribed to.
Please see the "Auto Send Commands" help topic for more
information about this feature.

<return to top>
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Terminal Session Modes
Indigo's terminal session window support two distinct
viewing modes. These are Standard Terminal Mode and
Direct Terminal Mode.

Standard Terminal Mode

Standard Terminal Mode is the default view mode for Indigo.
This view mode supports a continious scrollable data
window that displays all incomming data in the selected data
format. This view mode does not support VT emulation

commands, but rather displays a representation for each byte
received. In Standard Terminal Mode you cannot type data
directly into the data window, you must enter all data via the
data comand combo located in the session toolbar. If you are
not connected to a server or device that supports VT
emaulation, then this is the recommended view mode. The
view mode supports the most features and offers the most
flexibility for viewing the incomming data.

Direct Terminal Mode

Direct Terminal Mode is a new feature in Indigo Version 2.
This view mode supports VT100 and Linux emulation. This
includes the emulation support for screen colors, cursor
positioning, etc. Direct Terminal Mode does support direct
keyboard input in the terminal data window. This allows you
to type you commands directly into the data window and
each keystroke is sent to the server/device as you type. If you
are connected to a server or device that supports VT
emaulation, then this is the recommended view mode.

Session Toolbar Mode Button
In addition to changing the terminal session modes via the
"Session" menu, a simple mode toggle button is available
directl on the session toolbar. Pressing this button will toggle
the current session mode.
Go To Direct Terminal Mode
If this button icon is displayed in the session toolbar, the
session view mode is currently in Standard Terminal
Mode. Pressing this button will take you to Direct
Terminal Mode.

Go To Standard Terminal Mode
If this button icon is displayed in the session toolbar, the
session view mode is currently in Direct Terminal
Mode. Pressing this button will take you to Standard
Terminal Mode.
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Session Data Logging
It is sometimes important to capture all incoming data to a
log file. Indigo provides a way to capture this text in two
way. First, there is session data logging. This method is the
best option for constant logging of crucial data The incoming
data is logged to a file as it is received, so event in the event
of a computer crash or power outage, the log file will have
captured the data to the file.

Data Logging
To enable logging, select the "Log Data To File" option from
the "Session" menu.

Afer selecting the Log Data To File option, you will be
prompted with the dialog below:

Header / Footer
Include Log File Description Header
If this option is enabled, a log header including a
date/time stamp is included at the beginning of each log
file.
Include Log File Description Footer
If this option is enabled, a log footer including a
date/time stamp is included at the end of each log file.
Start New Log File
Allow Log File to Grom Continiously
If this option is selected, all sessing logged data will be

included in a single log file. This is the recommended
option if you are logging data on a temporary basis.
Start New Log File On Date Change
If this option is selected, a new log file will be created
for each new date that session data is received. This
option is recommended for long term or continious
logging operations.
Start New Log File After Number of Bytes Received
If this option is selected, a new log file will be created
after the user defined number of bytes have been
reached. This option should only be used for long term
or continious logging operations, or situation where
excessive amounts of data is being logged.
Auto Clear Screen Buffered Data Upon A New Log File
If this option is enabled, the session data on screen will
be cleared when a new log file is generated. This option
is used in conjunction with the Start New Log File On
Date Change or Start New Log File After Number of
Bytes Received options. This option is recommended to
conserve the computers memory.
Auto Start Logging When Session is Opened
If this option is enabled, logging will automatically start
each time this session file is opened.
Log Data
Include Time Stamp on each Log Data Line
If this option is enabled, each data line that gets logged
will be pre-pended with a time stamp. The time stamp
format can be configured using "hh" for hours, "mm"
for seconds, and "ss" for seconds.
Log File
Here you can specify the log file name you wich the
session to log data to.

If eaither the Start New Log File On Date Change or
Start New Log File After Number of Bytes Received
option is enabled, you will be given additional options
in the log file configuration section. The additional
options will allow you to specify how the incremental
new log files will be named. You can choose from the
options to simply place a date stamp in the filename or
to include an auto incremening number placed at then
end of the log file name.

Save / Export Session Data
The alternate method to data logging is to simply export the
session window data. This will create a snapshot text file of
the existing data on screen. This method will not however,
continuously log incoming data. You can export the session
data by selecting the Save Data, Save Data As, or Export
Data menu option in the File menu.

See the help topic "Export Session Data" for more
information.

Indigo Terminal Emulation Software ®

Serial Pass Mode
Indigo also has a Serial PASS Mode Utility. With serial pass
mode, you can use two serial ports on the computer and
connect between two devices. Serial pass mode will allow to
to use Indigo to view the serial communication between the
two connected devices. This feature allows you to analyze
protocol and traffic on the serial line. You can also specify
data line headers to indicate which port sent which data. To
enabled pass mode, you should have a serial session open
and then select the "Pass Mode" option from the "Session"
menu.
A pass mode configuration dialog will appear allowing you
to configure the aux com port settings and prefix headers.
Click the "Enable Pass Mode" button to enter into pass
mode.

To disable pass mode, simply return to this dialog and click
the "Disable Pass Mode" button.
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Syntax Color Editor
Indigo can display keywords of incoming session data in
alternate colors to help make the text stand out. Using the
Syntax Color Editor, you can create different colorization
filters. Each session file can have it's own unique session
color filter. To access the Syntax Color Editor, select the
"Syntax Color Editor" option in the "Tools" menu.
You can define three separate color representations, and enter
as many keywords as you like denoting which of the three
colors you wish it to appear as.

Additionally, there are string delimited and comment style
delimited color filters as well. The color filter will color all
data inside the delimiters as specified by the color filter file.
To apply a color filter to an open session file, select the
"Syntax Color Filter" option in the "Session" menu. Then
select which color template to use.
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Export Data
Indigo can export the session data text to a file or email.
Select the "Export Data" option in the "File" menu.

Export Data as File - export session data of current
session window to a text file. If text is highlighted in the
session window, only the highlighted text will be
exported to the text file.
Export Data as Email - export session data of current
session window to an email. If text is highlighted in the
session window, only the highlighted text will be
exported to the email body.
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Advanced Tools
This section is provided to discuss and demonstrate many of
Indigo's advanced features and tools.
Advanced Tools

Internal Commands
Advanced Send
Command
Custom Data Format /
Editor
Auto Send Commands
Global Session
Template
Post Processing Script
Command VB
Scripting
Scripting UI Library
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Internal Commands
Indigo contains an internal command processor that
intercepts commands to perform program operations
rahter than sending data to the terminal session. The
internal command processor supports the following
commands:
--------------------------------------------------------------------- INDIGO: Internal Command Listing --------------------------------------------------------------------- cls : clear screen - :help : display internal command listing - :? : display internal command listing - :d : disconnect session - :c : connect session - :rc : disconnect, then reconnect session - :t : toggle connection state - :reboot : reboot session - :log : toggle session data logging on/off - :log:<logfile> : start logging data to specified log file - :macro:<macro #> : execute a macro by macro number - :tileh : tile windows horizontally - :tilev : tile windows vertically - :cascade : cascade windows - :maximize : maximize session window - :minimize : minimize session window - :properties : edit session properties - :launch:<filename> : launch a file - :web : open web browser to current address - :web:<address> : open web browser to speficied address - :close : close session - :closeall : close all open sessions - :exit : exit program - :about : display about dialog - :helpfile : display Indigo's help file -

- :p:<milliseconds> : pause remaining commands (non-blocking) - :s:<milliseconds> : sleep remaining commands (blocking) - :@<script.function> : execute VBScript method in script file - :=<scipt code> : execute VBScript code ---------------------------------------------------------------------

You can view this list inside an Indigo open session
window at any time by sending the ":?" command.
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Advanced Send Commands
When communicating with certain equipment, it is useful to
send data to the device in other data types. Indigo's supports
sending data in ASCII, HEXADECIMAL, DECIMAL,
OCTAL, and BINARY. If a command is encapsulated in
double quotes " Indigo's command interpreter will decode
the data types and send in the proper data formats.
Below is a an example of the send command: HELLO
Data Type:
ASCII
Decimal

Hexadecimal

Octal
Binary
Mixed

Advanced Send Command:
"'HELLO'"
or
"'H','E','L','L','O'"
"72,69,76,76,79"
"48h,45h,4Ch,4Ch,4Fh"
or
"$48,$45,$4C,$4C,$4F"
"110o,105o,114o,114o,117o"
"01001000b,01000101b,01001100b,01001100b,01001111b"

"01001000b,69,'L','L',4Fh"

You can mix the data byte formats, the command interpreter

will decipher each byte separately. Each byte should be
separated by commas, except for multiple ASCII bytes, they
can be together inside the single quote encapsulation.
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Custom Data Format
Indigo's ability to display incoming data in different byte
format also includes the capability to customize a format
specifically for your needs. You can create, save, and load
custom data format templates using the Custom Data Editor.
To access the Custom Data Editor, select the "Edit Custom
Data Conversion Format" option in the "Tools" menu.

Each row represents the particular byte value, the column
highlighted in green will be the textual representation that is
displayed when that particular byte is received. In the
"Custom" column, you can enter your own textual
representation. To select a particular column simply double
click the cell, or press the "Space" or "Enter" key on the

keyboard while the cell has focus.
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Auto Send Commands
Indigo's provides two mechanisms to automatically send
commands to a terminal session when the connection is
established. There is a global send command list and a
individual session specific send command list. A session can
subscript to one or both of these lists.
The global send command list can be accessed through the
"Program Preferences" option of the "Edit" menu.

Secondly, in a sessions properties dialog, there are
checkboxes that allow you to specify which or both of the
lists this session will subscribe to.

If both lists are subscribed to, the global list of commands are
sent first, followed by the session specific command list.
The command list is send in the order as displayed. To
change the order, select a command entry and use the up or
down arrow buttons in the lower right corner to change its
position in the list.
Finally, at the bottom of the session properties dialog, there is
a single auto send command for disconnects. When you
attempt to disconnect, Indigo will send this command before
closing the connection.
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Global Session Template
As new session files are created, they will inherit a default
set of properties from the global session template. You can
modify these default session properties though the "Program
Preferences" option in the "Edit" menu. On the "Session" tab,
click the "Change Default Session Properties" button. A
session properties dialog will appear where you can set all
the desired options.

(Note: changes made to the global session template will only
apply to session files created after the changes. If will not
alter any existing session files.)
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Post Processing Scripts
Indigo supports an advanced feature called Post
Processing Scripts. This feature essentailly allows you
to create custom script files (VBScript & JScript) that
can process the incomming session data before it is
dispalyed to the terminal session data window.
To enabled and configure this option, you must open the
session properties dialog and select the "Settings" tab.
The Post Processing Script is the last option in the list.
Selecting the checkbox in the list will enable this
feature.

To confiure the scipting options, first, you select the
scripting lanaguge that you wish to use. Indigo supports
VBScript (*.vbs) and JScript (*.js) files.
Second, you must select the script file that contains
processing code that you wish to execute. The script
files must be located in the SCRIPTS directory in
Indigo's program path.
C:\Program Files\shadeBlue\Indigo\Scripts

Finally you must select the actual function or subroutine
in the script file to execute.
The TEST button is available for you to test the selected
script function. The test will prompt you with simulation
data to send to your script function.
A sample VB Script file is included to serve as an
exmaple for you to create your own custom scripts.

PostProcessingSample.vbs
Please review this file for more details on how to define
compatible post processing script files.
Indigo's post processing script feature will support both
script functions and script subroutines. If a FUNCTION
is defined in the script file, you should specify the return
data text to be displayed to the session data window. If
you use a SUBROUTINE, Indigo will display the
unaltered recieved data to the session data window.
Note, when a call is made to the selected function of the
script, it is a blocking call. This means that Indigo will
wait until your script function or subroutine has
completed before continuing. If you script processing
logic is complex, it may degrade the performance of
Indigo or even crash the main program, especially if a
large volume of data is being continiously received. Use
the scriting feature with with care.
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Command Scripting
Indigo supports the ability to script data commands being sent to
the connected terminal server/device using VBScript. The script
can perform whatever sutom logic or processing is needed and
return the text or data to be submitted on the command. For
example, if you had a command to "SET TIME" on you terminal
server, you could create a script command to call the "SET TIME"
command and automatically include the time from the local
computer. The resulting command may look like this: "SET TIME
22:30"
The scripting command feature supports two methods to execute
scriptable commands. You can embed a command script directly
into a line of output data or you can call a script directly using an
internal command. Upon executing a vb script command, you can
call a function that is included an an extenal VB script file or you
can enter the VB script code directy on the command line.
If you choose to use an external VB scriptr file, you must include
the script file that contains function that you wish to execute in the
SCRIPTS directory in Indigo's program path.
C:\Program Files\shadeBlue\Indigo\Scripts

Embedded Command Scripting

Embedding a script command directly in data line.

Format for calling a function in an external VB script file.

[@:ScriptName.MyFunction(Param1,Param2,...)]
Example command.
SET TIME [@:MyCustomScriptFile.GetTime()]

Format for executing VB script code directly.

[=:VBScriptCode()]
Example commands.
SET TIME [=:InputBox("Enter time:", "Title", "12:00")]
SET TIME [=:FormatDateTime(Time,vbShortTime)]

The command processor determines that script commands are
present by the inclusion of the starting characters [@: or [=:
and the ending character ] . All of the text in between these script
markers is replaced with the text returned from the VB script.
Thus, in the examples above, the resulting command text which is
submitted to the connected terminal session would look like this:
"SET TIME 22:30".

Internal Command Scripting
Alternately, you can also call scripting command via the internal
command system in Indigo. The primary difference between the
internal command method and the embedding method is that other
command line data cannot be included on the internal command

method. This means that all of the command data to be submitted
to the terminal session must come from the VB script code or
function.
Executing a script command using internal command format.

Format for calling a function in an external VB script file.

:@ScriptName.MyFunction(Param1,Param2,...)
Example command.
:@MyCustomScriptFile.GetTime()

Format for executing VB script code directly.

:=VBScriptCode()
Example commands.
:="SET TIME " & InputBox("Enter time:", "Title",
"12:00")
:="SET TIME " & FormatDateTime(Time,vbShortTime)

The command processor determines that this is an internal
command because the first character is a : . If the second
character is a @ then and external VB script file is called. If the
second character is a = then the VB code is execute directly.
Thus, in the examples above, the resulting command text which is
submitted to the connected terminal session would look like this:
"SET TIME 22:30".
UI Library

One very useful feature of command scripting is the ability to
prompt the user for input or a decision before submitting a
command. To support the need for user interfaces in command
scripting, Indigo includes a UI (user interface) library that
provides common user interface components can can be accessed
using command scripting.
<click here for more information on the UI library>
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Scripting User Interface Library
UI Library
One very useful feature of command scripting is the ability to
prompt the user for input or a decision before submitting a
command. To support the need for user interfaces in
command scripting, Indigo includes a UI (user interface)
library that provides common user interface components can
can be accessed using command scripting.
(The UI Library is used in conjunction with Command
Scripting.)

The UI Library is included as on open source VB script file
and is located in the program SCRIPTS directory under file
name "UI.vbs".
C:\DEV\shadeBlue\Indigo\SOURCE 2.0\Scripts

You can make any modifications or additions you wish;
however, it is recommended to save your custom script file
under a different filename. Future updates from shadeBlue to
this file may overwrite your customizations if they are
included in "UI.vbs".
The UI Library includes the following callable user interface
elements:

Text
Range
Slider
Error Message
Informational Message
Warning Message
Confirmation (yes/no)
Date
Time
List
Combo List
Combo Edit List
Prompt for Text
Format:
Text(TextMessage, DefaultValue)

Example:
:@UI.Text("Enter Your Name", "John")

<return to top>

Prompt for Range
Format:
Range(TextMessage,DefaultValue,MinRangeValue,
MaxRangeValue)

Example:
:@UI.Range("Enter Your Age",21,1,110)

<return to top>

Prompt for Slider
Format:
Slider(TextMessage, DefaultValue, MinRangeValue,
MaxRangeValue)

Example:
:@UI.Slider("Enter Your Age",21,1,110)

<return to top>

Prompt Error Message
Format:

Error(TextMessage)

Example:
:@UI.Error("This is an error message")

<return to top>

Prompt Informational Message
Format:
Info(TextMessage)

Example:
:@UI.Info("This is an informational message")

<return to top>

Prompt Warning Message
Format:
Warn(TextMessage)

Example:

:@UI.Warn("This is a warning message")

<return to top>

Prompt Confirmation Dialog
Format:
Confirm(TextMessage, CommandYes, CommandNo)

Example:
:@UI.Confirm("Are you sure?", "YesCmd", "NoCmd")

<return to top>

Prompt for Date
Format:
Date(TextMessage, DefaultDate)

Example:
:@UI.Date("Enter birthdate", Now)

<return to top>

Prompt for Time
Format:
Time(TextMessage, DefaultTime)

Example:
:@UI.Time("Enter Alarm time", Now)

<return to top>

Prompt List
Format:
List(TextMessage, DefaultValue,
CommaDelimitedList)

Example:
:@UI.List("Select color","Red",
"Black,White,Red,Green,Blue")

<return to top>

Prompt Combo List
Format:
Combo(TextMessage, DefaultValue,
CommaDelimitedList)

Example:
:@UI.Combo("Select color","Red",
"Black,White,Red,Green,Blue")

<return to top>

Prompt Combo Edit List
Format:
ComboEdit(TextMessage, DefaultValue,
CommaDelimitedList)

Example:
:@UI.ComboEdit("Select color","Red",
"Black,White,Red,Green,Blue")

<return to top>
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Web Update
Indigo fully supports automated online software updates.
You can check for updates at any time by running the
WebUpdate utility.
To check for updates to Indigo, select the "Web Update"
menu item from the "Help" menu. The WebUpdate utility
will connect to the update servers at shadeBlue software and
determine the latest version. If updates are available, it will
prompt you with the latest version information. Simply click
OK, and the WebUpdate utility will download the required
software updates. Upon download completion, Indigo will
close and the update installer will run. After the update
installer is complete, you will need to re-start Indigo. You
will now be running the latest version
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License Deregistration
Indigo licenses can be deregistered from your computer.
Deregistering will free the license for reuse and render the
working copy of Indigo inactive. You must deregister the
license in the event that you upgrade computers, or simply
wish Indigo to be installed on a different PC.
To deregister Indigo's client license, from the main menu,
click the "Help" menu and then the "Registration" option.
This will display Indigo's registration dialog.

Continue by clicking the "Un-Register" button in the lower
left side. Indigo will then prompt a confirmation message
notifying you that it will no longer run on this computer.
Continue by clicking the "Yes" button.

Now the deregistration process is complete. Indigo will
display a dialog providing the original software serial
number and the deregistration key. Simply email the original
software serial number, the deregistration key, and the
software serial number from the new installation to
info@shadeblue.com. Upon confirmation, a new
authentication key will be returned.
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Contact
You can view the latest details and version information
online at:

www.shadeblue.com

All questions including support, sales, and general inquiries
should send an email to

info@shadeblue.com

